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Maintaining a Web Site 

The Process 
There is a standard process to follow whenever changes to a web site are needed: 

1. find the page(s) in your browser and looking at their URL for their location on 
the server. For each page do the following using Dreamweaver: 

a. download the latest version of the page(s) from the development 
server, webdev, to your local computer (check-out) 

b. make the required changes to the page text and images using 
Dreamweaver 

c. upload the changed page back to the development server, webdev 
(check-in) 

2. preview the changed page(s) in your browser and checking all aspects of the 
page, in  particular test all links and ensure the page layouts are correct  

3. after testing, upload the changed page(s) to the live site using the Webaccess tool, 
which is a web interface to a range of tools for working on your web site. 

 

Filenames 

Filenaming guidelines 
Throughout the University of Adelaide web site, index.html is the default filename in 
each folder. Therefore it is recommended that the main file in each folder be called 
index.html. This is particularly important in the home folder of each site. If there is 
not an index.html file in a folder and a user types in the folder name in their 
browser they will see a listing of the files in the folder rather than a webpage. 
Therefore if the index.html file is used as the top level page in each folder, a user who 
enters just the folder name in the URL, rather than specifying a page, will see the 
webpage rather than a listing of the folder within the site. 
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Lower level pages within the structure of the site can sit within a folder that already 
contains an index.html page and be given an appropriate filename. This is suitable for 
pages that are likely to remain single pages within the section of the site and not be 
expanded to multiple pages in the future. If a page is likely to be expanded then it is a 
good idea to keep it as an index.html page within its own folder. 
 
Using spaces and special characters in filenames can cause problems with some 
browsers, therefore it is strongly recommended that filenames should be made up 
of only lowercase letters, numbers and underscores. This naming scheme is 
recommended for all files that should also be used for naming documents and images 
that are used on web sites. That is, avoid using uppercase letters, spaces and other 
special characters when naming all files for the web. 
 
Note that as the web server used for the University of Adelaide is a unix server, the 
preferred extension for html files is .html rather than .htm. 

Finding the page to edit 
To find the page you want to edit, use your browser and to find the page and look at 
the URL.  
 
The first part of the URL is your site. This will usually be either 
http://www.adelaide.edu.au/yoursite/ or http://www.yoursite.adelaide.edu.au. The 
remainder of the URL is the path of folders, and in some instances also a filename, 
giving the location of the page within your site.  
 
If the URL ends with a “/” then the file to edit will be the index.html file within the 
folder specified. If the URL ends with <filename>.html then you will need to edit that 
file. As an example, consider the following URL: 
http://www.adelaide.edu.au/testing/upload/  
First discard the site part of the (URL http://www.adelaide.edu.au/testing/ ) and look 
at what remains. In this instance it is /upload/ therefore the file to be edited will be the 
index.html file within that folder. However if the URL were: 
http://www.adelaide.edu.au/testing/upload/access.html 
the page to be edited would be the file access.html within the /upload/ folder. 

Starting Dreamweaver 
To start Dreamweaver, click on the Start button on the taskbar, 
select Programs from the list, 
select Macromedia, 
select Macromedia Dreamweaver MX 2004. 
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When you first start Dreamweaver your screen should contain the areas shown below. 
These can be dragged to different areas of the screen if required.  
 

 
 
The main area of the screen is the editing window that will be blank until a page is 
opened for editing.  
 
Directly below the editing window is the properties box. This provides you with the 
means to change the details you are editing within a page, showing the editing options 
available for the selection in the editing window, and is similar to the word editing 
toolbar. 
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The other important section of the screen is the file management window, usually 
shown on the right hand side of the window. This manages all the functions involving 
files in your site and allows you to transfer the files between your hard drive and the 
web server.  

Setting up Sites 
 
When you begin using Dreamweaver, you should set up your preferences and set up 
connections to the sites you will be working on. Additionally, if you are given access 
to new sites you will also need to set up the sites within Dreamweaver before you can 
access them. Refer to the notes on Setting up Sites in Dreamweaver for instructions 
on how to do this. 

Site Files 
 
The file management window, displayed on the right hand side of the screen by 
default, allows you to manage the files in your site.  
 
This is where you select the file(s) to work with. The window can be set to display the 
files on your hard drive (local view) or the webdev server (remote view). From this 
window you can transfer files between the server and your local drive, you can open 
files for editing and you can create, rename or delete files. 
 
Use the Site Files window to manage all your uploading and downloading between 
your hard disk and the server. This feature uses FTP to transfer the files but with 
several additional features built in. The Dreamweaver site management window looks 
similar to Windows Explorer and allows you to see the whole structure of your site at 
once. One of the advantages of this site manager is that it maps the site on the server 
to the local site and so once the site is set up, it always makes sure that files are 
transferred into the correct folders.  
 
To work on the files on the server you must first connect your computer up to the 
server. To do this click on the connect icon near the top of this window. This icon 
looks like a power cable connection.  
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You can choose the view you want to use by selecting the option from the drop down 
box. When your site is already set up and you are simply editing files that you already 
have on the site, either view can be used. If you are using the pointer option to link to 
other pages in your site, then the local view must be used as the file locations are 
determined relative to the current page’s location on the local site.  
 
However, if you are wanting to access new files in the site, created by another web 
developer, or files that you have not previously downloaded to your hard drive, it will 
be necessary to work on the remote view.  
 

 
Clicking on the same icon from the site files window will return the screen to the 
editing style window,. Note that when you open a file for editing, Dreamweaver will 
return to the editing style layout with only the local or remote files being displayed. 
 
The items on the files menu have the following purpose: 
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Site: This is where you specify the site you are currently connecting to. It is 
also where you can enter connection details for a new site. 
View Type: Determine whether local files (the local hard drive) or remote 
files (on the web server) are displayed in the files window. 
Connect: Toggle icon to connect or disconnect to/from the site specified in 
the site field. If the power plugs are joined and the green light is displayed (as 
shown), the connection to the remote site is active. If the power plugs are 
separated and the light is not on (black) then there is no connection. 
Refresh: Clicking this icon refreshes, and reorders where necessary, the 
listings of both the local and remote sites. 
Upload/Download icons: The green arrows get files from the server and put 
them onto your hard disk. The blue arrows move files from your hard disk and 
put them on the server.  
Expand/Contract view: Clicking this icon switches the window display from 
the default editing window that shows the editing screen and a single file view 
to a window showing both local and remote files at the same time. Clicking on 
the icon again from the files view, or opening a file for editing, will return to 
the editing style window. 

Uploading and Downloading Files 

Get Files 
When you want to download a site or webpage to your hard drive so you can view it, 
you can use the green arrow to “Get” the file. This will copy the file from the server 
to your local drive as a read only file. You can view the file but not save changes 
unless you check it out (see below). When you open a file on your hard drive to view 
it (without checking it out), it opens the version of the file that is currently on your 
hard drive and other users still have access to the main copy of the file on the server. 

Put Files 
Put files copies a file from your local drive to the server. This is rarely used because it 
easy when doing this not to unlock a file when you have finished editing changes. 
Instead it is recommended that you always check in a file to upload your changes (see 
below). 

Check In and Check Out Files 
Using the Check Out (green-ticked arrow) and Check In (blue- padlocked arrow) 
buttons ensure your site remains consistent by two methods. First, it prevents more 
than one person at a time from editing a file and second it always copies the latest 
version of the file from the server to your hard drive when you lock it for editing so 
that it is not possible to edit an older version and overwrite another user’s changes. 
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Check Out Files 
To check a file out so that you can edit it, select the file you want to change then click 
the ticked green arrow button to mark the file as checked out to you. This copies the 
current version of the file from the server to your hard drive ready for you to edit, 
ensuring it contains any edits another user may have added since you last downloaded 
the files. The check out option also locks the files so that other users cannot make 
changes to the file until you have checked in the file. 
 
Alternately, if you double click on the file you want to open, the following window 
appears and you can select Check Out to open the file for editing. 
 

 
 
Note that if you do not want to make changes to the file, you can click on View to 
open the file as read only.  
 
The third way to check out a file for editing is to right click on the file and select 
Check Out from the drop-down menu that appears. 

Check In Files 
When you have completed editing, Check-In the file by clicking the padlocked blue 
arrow button To check a file in so that it is free for others to edit, click on the file to 
select it and then click the padlocked blue arrow button. This puts your new changed 
file on to the server and unlocks it for others to use. Note it also makes the file read 
only on your hard disk so you will need to check it out again if you want to make 
further changes. This ensures that you have the latest version of the file whenever you 
edit it and will not be accidentally overwriting another user’s changes made since the 
last time you have edited the file. 
 
You can also check in a file by right clicking on the file and then selecting Check In 
from the menu that is displayed. 
 
When Checking In a file, always make sure the correct file is selected, usually shown 
by the file being highlighted in blue, before clicking the Check In button. This is 
important because it is possible to check in a file that isn’t currently checked out and 
thereby possibly overwriting a page on the server with an older version on the hard 
drive.  

Undo Check Out 
Undo check out is useful if you want to revert to the version of the page on the server 
and lose the changes you have made to the file on your hard drive. Undo check out 
copies the file from the server overwriting the version of the file on your hard drive, 
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causing your incorrect changes to be overwritten and allowing you to start afresh with 
making changes to the file.  
 

Editing Pages in Dreamweaver 

Editing Display Options 
When editing a page in Dreamweaver, there are several options of how the page can 
be viewed. The various options can be selected by clicking on the view type icons at 
the top of the editing window. The options are: 
 

 
 
Code view: This shows the html code for the page and is particularly useful when 
debugging problems with pages. 
Split view: This view shows the both the design view and the html code for the page. 
When an item is selected in the design view, the relevant section of the html code is 
highlighted in the code window.  
Design view: Generally this is the most useful view. It shows the page in the editing 
window much as it will appear when it is displayed in a web browser. Some of the 
formatting is not visible in this view, however it will show text tables and images in 
the positions they will appear when viewed through a browser. Some formatting that 
is handled by the University style sheets does not appear when viewing the pages 
through Dreamweaver, however the layout of pages can be seen using this view. 

The Properties Box 
Many editing operations can be performed on the content of a webpage using the 
fields in the properties box. When you check out a page and open it for editing, the 
properties box becomes active. The options available in the properties box are context 
sensitive, meaning they change according to what you are editing at the time, for 
example appropriate options will be shown for text, images or tables.  
 

 
 
The fields in the toolbar have the following meaning: 

Format: Formats text according to pre-defined heading styles. The formatting 
applies to the current paragraph. This is a recommended way of formatting 
text. 
Style: Set the style for the text – do not use.  
Bold: Set selected text in bold type. 
Italic: Set selected text in italics. 
Justify: Left, centre, right or full justify selected paragraph. Avoid using 
justification. 
Link: Create or change a hyperlink on selected text. 
Font: Apply font to selected text – do not use. 
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Size: Specify relative size of selected text – do not use. 
Colour: Specify font colour of selected text – do not use. 
Bullets: Set selected paragraphs as bullet or number points. 
Indent/Outdent: Indent or outdent selected paragraph.  
Target: Specify frame for opening link and is used to open a link in a new 
window. Links should not automatically open in a new window. 
 

Formatting Text 
• Formatting Headings 

Use the format field in the toolbar to format text within the webpage. The 
formatting style is applied to the selected paragraph of text. For body text, this 
field will be set to either Paragraph or None. 
In order to specify text as a heading, click anywhere in the line of heading text 
and select one of the heading styles Heading1 to Heading 6 from the drop 
down list. This will format the text as the appropriate level of heading. For an 
example of the way the heading will look on a live webpage, go to the 
headings page on the University web guide at: 
<http://www.adelaide.edu.au/webstandards>. 

• Heading 1 
The heading shown at the top of each webpage should be set in Heading 1 
style. It is recommended that the heading text be set as the likely content of a 
link that someone would click on to get to this page, that is, it should generally 
be the text used for the navigation link used to get to the page. 

• Character formats 
Bold and italics formatting can be applied to selected text for minor headings 
and highlighting within a paragraph. These are character based formatting 
options and can be used for characters, words or paragraphs. 

• List items 
The standard list type of unordered list (bulleted list) and ordered lists 
(numbered lists) should be used. These present the information in an easily 
readable form and meet accessibility guidelines.  

• Use Enter to end paragraphs 
When content is cut and pasted from Microsoft Word, a paragraph return 
(enter key) is often replaced by two line breaks (shift-enter shift-enter). This 
gives a similar appearance in a browser, but as it does not mark the correct end 
of paragraphs can cause problems as html mark-up is often applied to 
paragraphs. That is, heading styles and lists may appear to run on down the 
page if line breaks are used instead of returns. For this reason, it is 
recommended that Dreamweaver preferences be set to show all hidden 
characters and that when editing, these double line breaks should be replaced 
by a single return. 

• Avoid font formatting 
Do not use Font, Size or Colour to format text as these types of formatting are 
not compatible with the style sheets used with the University templates. If they 
are used, they will be ignored when the page is displayed and so the page will 
not have its intended appearance. In addition, they may cause problems with 
the display of heading styles, so that headings may appear as normal text.  
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• Avoid Blockquote 
Avoid using blockquote (indent) to emphasise text as this should be reserved 
for quoting blocks of text. 

Creating and Editing Links 
To create a link, select the text that is to appear as the hyperlink and then click in the 
Link field. Enter the URL of the link in the entry field. There are several ways of 
doing this.  

External Links 
For links to sites or pages outside your site, type the full URL into the link field. The 
simplest way to do this is to go to the link in your browser and use cut and paste to 
copy the link into the link field. This ensures that you are entering the URL for the 
correct page and that the link doesn’t contain any typographical errors.  

Internal Links 
If the link is within your site, you should use a relative link to describe the link. That 
is, the link is defined within the structure of your site in relation to the current page. 
This is the recommended way of entering links to pages within your site, as it will not 
cause the links to break if the site is moved. 
 
To create a link to another page in your site you can type the link or you can either 
browse or point to enter the link.  
 
To browse, click on the “folder” icon to the right of the link field and use windows 
browse to select the link you require.  
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Alternately, click and hold the circle “pointer” icon to the right of the link field and 
drag across to the file you want to link to in the Site Files window and let go of the 
pointer.  
 

 
 
In order to be able to use either browse or point to create a relative link you will need 
to have the file you want to link to on your local site so that Dreamweaver can 
determine its position within the site structure.  
 
To drag to the link using the point option you will need to be viewing local site in the 
site files window. If the pointer is not dragging to the links, make sure that the local 
site is displayed in the file management window. If links are not working, click in the 
link and then click the browse folder icon and ensure that the last option, relative to, is 
set to Document and not Site Root. 
 
To change a link, click anywhere within the link text and use the same techniques to 
change the link details within the link field. 
 
To delete a link, click anywhere within the link and delete the link details from within 
the link field. 

Linking to Files 
In addition to linking to webpages, it is also possible to link to other types of files, 
such as word documents, pdf files and excel files. The process of linking to another 
type of file is exactly the same as for a webpage. If you are linking to a file within 
your site, you must also make sure that the file exists in your site and is uploaded with 
the webpage that links to it.  
 
To link to a file, first use windows explorer to put the file into the relevant folder in 
your local site. This is usually either a docs folder or the current folder depending on 
your site set-up. Once you have copied the file into your local site using windows 
explorer, it will immediately become visible in your local site within Dreamweaver. 
You will need to Check-In the file using Dreamweaver to upload it to the 
development site. You can then type in the URL, browse or drag a link to the file in 
the usual manner.  
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Creating Email Links 
To create email links, highlight the text to appear as the link and in the link field enter 
mailto:email_address where email_address is the email address that should receive 
the email when this link is clicked.  
 
Alternatively, Dreamweaver allows several other methods of entering email links. 
Either you can select Insert from the toolbar and then choose Email Link from the 
drop down menu. In the pop-up window you can then insert the text for the link and 
the email address to go to, or highlight the text to be the email link and click on the 
email icon in the insert toolbar and type the email address that the link is to go to.  

Creating and linking to Anchors 
Anchors are specified points within a webpage that can be linked to. For example, a 
page may have a mini-menu at the top of the page which links to the main headings 
throughout the page. Clicking on the links in the menu will take the user to the 
relevant point within the page. 
 
To link to an anchor you must first create the anchor and then you can create the link 
to go to that anchor. 
 
To create an anchor, go to the point where the anchor is to be set and select Insert 
from the top menu bar, then select Named Anchor. Enter a name for the anchor. 
Pressing Control, Alt and A together will also bring up the anchor definition window. 
 
A link can then be created to the anchor from within the page containing the anchor 
by typing #anchor_name within the link field when creating a link as described 
above. Alternately, you can hold down the pointer and drag it to the anchor, which 
will also insert it as a link. You can also link to an anchor in another html page by 
typing web_page#anchor_name for an anchor set within that page. 

Images 
Images may be used to add or supplement information in webpages, however it is 
important to consider the purpose of an image within a page before using it. Images 
should be used sparingly and to value add, not simply as decoration. The use of 
images in the page header or built into the site design can provide interest more 
effectively than ad hoc images scattered throughout a site. 
 
All images should use Alt tags to give a text alternative to the text. This text should 
provide information about the image that would be relevant for users who are using a 
screen reader or browser that does not use images. Alt tags can be entered in the Alt 
field in the image properties box. 
 
Also, avoid using image as bullet points for lists as these not meet accessibility 
guidelines. Instead use standard unordered lists as these meet accessibility guidelines. 
 
Images used in webpages should be either in .jpg, .gif or .png format. Images are 
displayed at a resolution of 72dpi and should be kept to a reasonable display size for 
showing on a page so that users with even a 640 pixel width screen should be able to 
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see the complete image without scrolling. In general, this means that an image should 
not be wider than 300 or 400 pixels wide. 
 
The image should be created to the size it is being displayed rather than being resized 
from within Dreamweaver. This is because resizing the image within the webpage 
may cause the image to appear pixelated and if the image is resized to display smaller 
than the actual image size, the image will still be downloaded as the full image with 
the associated download time. Please contact the web team for more information on 
images.  

Inserting Images 
To insert an image into your web page, first place your web ready image file within 
your local web site on your hard drive, in the images/ folder created specifically for 
storing images. Do this using windows explorer to add the image to your local site 
and then Check-In the image to upload it to the development server.  
 
To insert the image into your page, click on the Insert Image icon in the insert 
toolbar or go to the Insert menu and select Image, or click Control-I. A pop-up 
window will be displayed allowing you to select the image file, or type its name. 
 
By default, images are displayed with a single line of text alongside which is 
generally not the format wanted. To wrap text around the image go to the Align field 
in the properties box and select Left or Right from the dropdown list, depending on 
which side of the text you want the image to appear. 

Changing Images 
Once an image has been inserted in a page it is possible to change it for another image 
by clicking on the image, clicking and holding down the pointer icon to the right of 
the image source file information and dragging to another image in the local site. 
Alternatively, clicking on the image and then clicking on the browse icon to the right 
of the image source file information. You can use the windows browse to select 
another image to appear in this position in the page. 

Linking from Images 
Once an image is inserted into a webpage, it can be used as a link in the same way as 
text by entering the URL in the link field that appears in the properties box. Just as for 
text, it is possible to link to another page, another file such as a word document or pdf 
file, an anchor or an email link. 

Tables 
Tables are designed to provide a means of displaying tabular data effectively. In the 
past tables have also been the means of laying out pages, however advances in web 
technology mean that this has now been replaced by other means with current 
browsers and where possible this should be avoided.  

Inserting Tables 
To insert a table click on the Insert Table icon in the objects toolbar or go to the 
Insert menu and select Table. Select the appropriate options for the table in the pop-
up window that is displayed: 
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Enter the number of rows and columns and percentage width you require for the table. 
Cell Padding is the space between the border of the cell and the text or images and the 
Cell Spacing is the space between table cells. Either of the following settings work 
well for tables: Border = 1 with Cell Padding = 5 and Cell Spacing = 0, or 
Border = 0 with Cell Padding = 3 and Cell Spacing = 2. 
 

Changing Tables 
There are numerous options available for modifying a table within your webpage. 
Some of these options are quickly accessible through the properties box. If a table cell 
is selected, the following options are available in the properties box: 
 

 
 
The table cell options allow you to set or change the following: 

Horz: Horizontal alignment of cell contents 
Vert: Vertical alignment of cell contents 
W: Cell width 
H: Cell height 
No Wrap: If this is selected, contents of the cell will not wrap 
Header: Defines this cell as a header with emphasised formatting. This can be 
applied to any cell(s) in the table. This is a simple and effective way of 
differentiating a row, column or individual cells from the remainder of the 
table. In university web pages, cells denoted as header cells are displayed with 
a grey background and the text shown in bold.  
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Bg: Background image. Avoid using as this does not work with all browsers 
and has different results with different browsers. 
Bg: Background colour for the table cell. Avoid using hard-coded background 
colours as setting colours using styles is preferable. Contact the web team for 
more information on doing this. 
Brdr: Border colour. Avoid using as this does not work with all browsers. 

 
If a whole table is selected, the following options are available in the properties box: 
 

 
 
The table options allow you to set or change the following: 

Table name: Table identifier. 
Rows: Number of rows 
Cols: Number of columns 
W: Table width (in pixels or percent) 
H: Table height 
CellPad: Space between table border and contents. ([5 or 3] recommended). 
CellSpace: Spacing in border. ([0 or 2] recommended). 
Align: Horizontal alignment of table, affecting text wrapping around table. 
Border: Border width. ([1 or 0] recommended) 
Bg Color: Table background colour. 
Brdr Color: Border colour. Avoid as this does not display consistently across 
browsers. 
Bg Image: Table background image. Avoid as this does not display 
consistently across browsers. 

Modifying Tables 
In addition to the changes that can be made to a table using the table and table cell 
properties boxes, there are a number of other table features that can be changed from 
the Modify tables menu. To access this menu, click on Modify in the toolbar and 
select Table from the drop down menu. 
 
Options include merging, and splitting, cells allowing for header cells that span more 
than one row or column and various options for inserting and deleting rows and 
columns as required within the table. 

Saving Webpages 
When you have finished making changes to the webpage you can save changes by 
selecting File and Save from the top menu bar or by closing the file and clicking Yes 
to save changes. 
 
Note that the last modified date shown in the page footer of each page in the 
University site detects the date that the file was last changed to display this 
information, therefore when you save a file the update information will automatically 
be updated with the current date so that others can see the page has changed. 
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Creating Pages from Templates 
There are three standard templates available for creating new web pages. These are as 
follows: 
tmpl_1.html: single column format without any navigation, generally used for wide 
tables or front pages. Rarely used.  
tmpl_2.html: the most commonly used format with a left hand navigation area and a 
right hand main page area. 
tmpl_3.html: similar to tmpl_2.html but with an extra column for images or side bar 
information. Rarely used. 
 
To create a new page from the templates, open the templates folder in your remote 
site and you will see the three available templates. Click on the appropriate template 
to select it. This will most likely be tmpl_2.html. Copy the template by pressing 
Control-C or right-clicking the mouse and selecting Edit -> Copy. Go to the folder 
where you want to create the page and paste the template by pressing Control-V or 
right-clicking the mouse and selecting Edit -> Paste. Rename the template to the 
required webpage name by right-clicking the mouse and selecting Edit -> Rename 
and typing the name you want for the page.  
 
This new page can then be checked out and edited as described above. Using this 
process to create new pages from templates will ensure that the pages refer to the 
correct include files such as the navigation files. 

Further Information 

Webstandards Guide 
The University of Adelaide web site has a sub site designed to provide information to 
people creating and maintaining web sites within the University. This can be found at:  
• The University of Adelaide Web Standards Guide: 

http://www.adelaide.edu.au/webstandards 
• Dreamweaver Preference Settings Information 

http://www.adelaide.edu.au/webstandards/develop/dw_prefs.html 
• Dreamweaver Site Set-Up Instructions 

http://www.adelaide.edu.au/webstandards/develop/dw_sites.html 
• List of header styles: 

http://www.adelaide.edu.au/webstandards/develop/headings.html 
• Upload information: http://www.adelaide.edu.au/webstandards/upload/ 
• Basic HTML information: http://w3schools.org  


